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Abstract: Geometric design of highway deals with designing of physical visible features of highway those comprise of horizontal
alignment, vertical profile, circular and transition curves, superelevation, Summit and valley curves, cross sectional elements,
sight distances and other features. From the safety point of view, road geometric features should be well designed as per the IRC
recommendation. In this research work, the horizontal alignment and vertical profile have designed of Balampur Ghat section in
the Bhopal-Vidisha Road which is in the Madhya Pradesh State of India. The objective of this research work is “Improvements
in the Horizontal alignment and Vertical profile of Balampur Ghat Section in Bhopal-Vidisha State Highway Road (SH-18)
using MX Road Software”. The design of horizontal alignment and vertical profile have been done for Balampur ghat section
approx. 2.0 km in length of State highway no. 18 (SH-18) of Madhya Pradesh. SH-18 is connected to Vidisha from Bhopal in the
state of Madhya Pradesh and having heavy commercial traffic. Balampur ghat section is hilly terrain and have two improper
horizontal curves along with 6.5% of vertical gradient and because of this reason that section is not safe for deriving therefore it
has become an accident-prone area and the accident-prone area have the human and economical losses so it should be improved
and re design of the horizontal and vertical alignment for safe design speed. The proposed methodology is on the basis of
inventory survey (preliminary survey), topographic survey and MX Road software. In inventory survey take the data of existing
road and find the suitable route of alternative alignment if re-alignment is required in the road. Then the topographic survey
done on the existing road and alternative alignment. Import the topographic data of the road in MX Road software for generate
existing surface of the road for design of horizontal alignment and vertical profile. As per IRC recommendations, there are two
alternative alignments designed of the existing ghat section. As per the outputs of this research work, the length of both
improved alignments is short as compare to existing road. There are no improper curves at improved alignment and maximum
gradient is 4.2% which is less than the existing gradient (6.5%). The minimum design speed is 40-50 kmph which was 20 kmph
in existing road. The both two improved alignments are safer as compare to existing alignment and the design speed of the
vehicle has been increased. The improved alignment 2 is straighter than the improved alignment The improved alignment has
also reduced the human and economic losses.

Keywords: Horizontal Alignment, Vertical Profile, Improvements, Design, Design Speed, MX Road Software.

L. INTRODUCTION

For the balanced development of any country, it is essential to provide a well-planned road network connecting all the villages and
towns. The development of the infrastructure in India is very fast and there are many developments have been done in last few
years. The development in transportation infrastructure plays a vital role in Indian economy. The road network plays an important
role for development of the country in steady growth. It is necessary to provide good road links between the villages and market
centers. The transport system affected directly to the developing countries. If the economic transport system is available from the
villages to other district headquarters and also for commercial stations than the overall economy can be grow easily. For the
uninterrupted movement of fast vehicles, the express ways give the full support to make the strong road network in India. In last it
will have to say that, for the fast growth of any countries the transportation systems should be strong in both terms of length and
quality to meet their demand for the developments.
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A. Bhopal - Vidisha Highway Road

The Bhopal-Vidisha State Highway (SH-18) connected to Vidisha from Bhopal. This State Highway is in the State of Madhya
Pradesh. The Highway started from Bhanpur square at Ayodhya Bypass (From km 0+000) in Bhopal and terminating at its junction
with NH-146 near Sanchi (To km 36+150). The total length of the road is approx. 36.150 km. This State Highway develop a
junction with NH-46 (Gwalior — Betul Road) at its km 6+300 and also cross tropic of cancer at its km 24+400. In this research
work, the alignment problem of Balampur Ghat section is discussed and the improvements are also done in the horizontal alignment
along with the vertical profile of the section from km 13+000 to km 15+000.
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B. Problem Identification

The existing ghat section has many problems which have identified in preliminary survey. Geometry of Balampur ghat section is not
as per IRC recommendations. The problems are given below-

1) There are many improper curves in existing ghat section and there is one horizontal curve has radius < 75 m. but as per IRC:
SP:73-2018 (Table 2.5), it should be min. 75 m in Mountainous terrain.

Table 2.5 Minimum Radii of Horizontal Curves

Nature of Terrain Desirable Minimum Radius | Absolute Minimum Radius
| Plain and Rolling 400 m 250 m
{Mountainous and steep 150 m 75m I

Table 1: Minimum radius of horizontal curves

Geometric Problem Of Balampur Ghat Section (Detail of “A”)

Approx. 40

Approx. 150
m Radius )

m Radius

Approx. 80
m Radius

Approx. 140
m Radius

Figure 3: Horizontal curves deficiencies

2) The profile gradient is > 6.0 % but as per IRC: SP:73-2018 (Table 2.7), it should be max. 5% in Mountainous terrain.

Table 2.7 Gradients
'Nature of Terrain g Ruling Gradient IF Limiting Gradlgrlt' ‘g
| Plain and Rolling | 2.5% | 33%
' Mountainous J\ 5.0% ‘ B 6.0°/?__~
' Steep ; 6.0% 7.0%

Table 2: Gradients on vertical curves
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Geometric Problem Of Balampur Ghat Section

Balampur maiag?

x

Figure 4: Vertical gradient deficiencies

3) If vertical gradient > 4 % at horizontal curve than grade compensation is required. As per IRC guideline for grade
compensation, it should be -

’ . 75
subjected to maximum of - Where R - Radius of horizontal curve in
m.

. 30+AR
Percent grade compensation = B
4) The existing ghat section is unsafe for road users and it is accident prone area.
5) The speed of the vehicle found 20 kmph.

C. Bentley MXROAD

The Mx software was initially developed by three local authorities in the United Kingdom, in the late 1970s. Back then, it was
known as MOSS till 1998. MXROAD software evolved subsequently with the merging of Infra soft Limited and Bentley System
Limited during January 2003.

Bentley MXROAD is an advanced, string-based modeling tool that enables rapid designing of all road types with accuracy. Using
MXRAOD, creation of design alternatives for the construction of an ideal road system can be managed with ease. Once a design
alternative has been authenticated, further details that are to be added to be design process can also be automated while using
MXROAD modeling tool, saving both time as well as money.

1) Features of Bentley MXROAD

a) Design Creativity.

b) Junction Design.

¢) Super-elevation Design.

d) Pavement Layer and Sub-Grade Design.
e) Final Drawings.

f) MX Command Language and Input Files.

2011
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2) Advantages of Bentley MXROAD
a) Time saving.
b) Higher accuracy.

3) Uses of Bentley MXROAD

a) Design of Horizontal and Vertical alignment of all types of Roads and Highways.
b) Design of Junctions.

¢) Pavement and Subgrade Design

d) Earthwork Calculation-Volumetric Analysis.

1. PROPOSED METHODS
A. Preliminary Survey Photographs
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Figure 5: Balampur Ghat Section

B. Design of Horizontal Alignment and Vertical Profile using Bentley MXRoad
Design the horizontal alignment and vertical profile of the Balampur ghat section as per IRC recommendations by using Bentley
MXRoad. Design steps of MXRoad software are given below-

1) Importing Survey Data

For importing survey data follow the steps which are given below-
> Importing topographic survey data (csv excel file) from the main menu bar, select File > Import > ASCII Import.
File View Tools Design Analysis Modify Display Dray

CAD Menu Q'O'S'gj'

New Plan Display...
Open Display/Drawing... # x View 1 -

Input... v = g). q}
Recent Files... > I x oo
Script Manager... N ——

Open Output File...

Open Journal File...

Print... -

Print Preview... -~

Batch Print...

-

UPM...

: v

File Management >

Explorer... -

Project Folder Explorer e

Convert to MXROAD SNC... i
__Import » | ASCll Import...

Export > ASCII File...

Close Project Eagle Point...

e Softdesk/LDD Alignment...
o VTSUSTZIUoTT Softdesk/LDD DTM...
I Animation LandXML...

GML OS MasterMap...
GEOPAK Survey...
LIDAR Data...

CAD Data...

12D...

HEC-RAS...

Figure 6: Main menu bar for ASCII Import
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» Select csv excel file in ASCII File and Select Use an existing file format if you have any existing Format otherwise Select
Define a new file format.

mx ASCIl Import - Specify ASCII file and format ? X
ASCII File I Newts I
IBaIampur survey 1.csv _J

Cancel |
Format

" Use an existing file format
[ =l =]

(¢ Define a new file format Options

AS0001

Figure 7: Specify ASCII file and format for ASCII Import

» Select Easting, Northing and Level in Type of data tool and click Next.

mx ASCIl Import - Type of Data ? X

Define which dimension is stored in which data field Next > l

First select and highlight a column in the grid below and then select the appropriate checkbox.

Every column with a green header will be imported. < Back
Cancel
v Easting [~ Feature Code / Point Code ;

v Northing

[~ Survey Point Number / Point ID

v Level

Line|Easting  [Northing

1| 759616.118 2589645.796
2| 759616 .017 2589645.557
3| 759615 .863 2589644 .964
4| 759615.742 2589644 .451
S| 759615.44 2589643.732
6| 759615.171 2589643.092
7| 759615.036 2589642.772
8| 759614.969 2589642 .612
9| 759614.781 2589641.938
1Nl 759614 A4A 25R9A41 A1R AS0002
Figure 8: Type of Data for ASCII Import
% MX: D:\PANKAJ\SATI\4th sem\MX Balampur\MX Bal d - [d: sem\mx P .dgn] - Bentley MXROAD V8i (SELECTseries 2) T =] x
File View Tools Design Analysis Modify Display Draw Visualise Report Quantities Add-Ins Help  Defaut ~/[Jo ~|=Z= o ~|= o - :[BALAMPURSURVEY1 SaEE S S
Frasiw -~ B-N-S-E-@-8B-O 8BARiZD
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/> Animation -~
Autoconv ertOFI @D @ @ Ve 2=
@ Mx Rl ==110F3 EY 23 5 [ ed BT > |MXKeyns _ ~ SinglePick _ ~ Unlocked _ ~ (1) MXOutput Window () 759960.991. 2587230.429
758881.7200. 2588332.2270. 466.9150 KeyPt
e ] > ~ @ GF 00 0000 0

Figure 9: Imported survey output
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2) Make Triangulation from Survey Data
For making triangulation follow the steps which are given below-
»  First create model for Triangulation from the main menu bar, select Modify > Edit Models > Create Model

Modify | Display Draw Visualise Report Quantities Add-In|
| Edit Models » [ Create Model...
Edit Strings > Create Composite Model...
Edit Point > Rename Model...
Copy > Delete Model...
Move 4 2D to 3D Surface...

Copy Transformation Wizard... Trim £0/a Botmday s

Cross Sectional Editor...
T e— oo
Figure 10: Main menu bar for Create Model

Free/secure Model...

» Then make triangulation from the main menu bar, select Analysis > Triangle > Triangulation from a String Model.

'"’S MX: D:\PANKAJ\SATN\4th sem\MX Balampur\MX Balampur.mmd - [d:\pankaj\sati\4th sem\mx balampur\draw.dgn] - Bentley MXROA

File View Tools Design @ Analysis Modify Display Draw Visualise Report Quantities Add-Ins Help Default
s Triangle » Triangulation from a String Model... ‘
FI bt o &~ @l < t,g ’] g g I
Tasks ceooe Isopachyte Triangulation from 2 String Models...
Contours 4 Isopachyte Triangulation from Triangulation Models...
) Tasks - -
Ridges and Valleys and Flow lines... R
R _BJ &"] e? L" Areas > Sub-divide Triangulation...

Volume >

€ Roundabouts Automatic Seeding...

@ =3 ¢ : Surface Checker... Group by Seeding...
= .
Surface Analysis... Group Individual...

<_ Civil Geometry Dynamic Analysis...
Volumetric Analysis...

Crossfall Checker...

A Data Acquisition

% Civil
2D Schematic Plan...

Group by Boundary...
Group by Seed String...
Group by Criteria...

Show Grouped / Ungrouped Triangles...

Print Preparation

Ungroup Triangles...

Visibility >
lkRoadSuits Design Checker...

Figure 11: Main menu bar for Triangulation

» Select csv excel file in Model to triangulate and select Model in Model to store Triangulation. Give Triangulation string name
TXO00 and click OK.

Triangulation from a String Model ?

Model Details | Boundary Details | Trimming Details |

Model to Triangulate
[BALAMPUR SURVEY 1

I No Masking

Model to Store Triangulation

[TRIA ~|
Triangulation String Name TX00 =
Triangulation-E xisting (TX) ¥

|v Display Triangles

TR0001

Figure 12: Triangulation from String Model
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Figure 13: Triangulation output

3) Design Horizontal Alignment
For design the horizontal alignment follow the steps which are given below-
» From the main menu bar, select Design > Quick Alignment > Horizontal Design.

I\4th sem\MX Balampur\MX Balampur.mmd - [d:\pankaj\sati\4th sem\mx balampur\draw.dgf|

Design | Analysis Modify Display Draw Visualise Report Quantities Add-Ins

Alignment... II, ~N N |

Quick Alignment ’ Horizontal Design... !
Best Fit Alignment 4 Vertical Profile...
Road Design »

Junction Design »

Pavement and Subgrade Design...

Design a String »
Amend a String »

Earthworks Wizard...

Drainage Design...

Figure 14: Main menu bar for Horizontal Design
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»  Select Design model in Model Name and select MCOO in Alignment string Name and click Next.

Quick Alignment - Model Selection ? X
Design Model
Model Name ’ Next > I
IDESIGN ~] e |
ance

Alignment String Name [MCOE‘ LJ J
{Road Centrelines (MC) ]| -

@HO001

Figure 15: Model selection for Quick Alignment

» Then open a designing tool and with the help of this designing tool, will design horizontal alignment of the road.

mx
L
2o o] o K v, p
* G O DS || AKX L XA X
Figure 16: Tool bar for Horizontal Design
L
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Figure 17: Horizontal design output
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4) Design Vertical Profile

For design the vertical profile follow the steps which are given below-

» From the main menu bar, select Design > Quick Alignment > Vertical Profile.

m’; MX: D:\PANKAJ\SATI\4th sem\MX Balampur\MX Balampur.mmd - [d:\pankaj\sati\4th sem\mx balampur\draw.dgn

File View Tools | Design @ Analysis Modify Display Draw Visualise Report Quantities Add-Ins

& Alignment...
FI vt rn & g - |‘, - Q.
| Quick Alignment » Horizontal Design... ||
Tasks Best Fit Alignment »||  Vertical Profile...
| 2 Tasks Road Design 122 105 IR e I el
i A = Junction Design »
R il g

Pavement and Subgrade Design...
€ Roundabouts

Pavement and Subgrade Design (to Existing Pavement

. Civil Geometry verlay Design (Template Method

A Data Acquisition

&

Civil
Design a String »
Print P :
rint Preparation Amend a String >

fRoadSults Earthworks Wizard...

\ Drawing Drainage Design...

Figure 18: Main menu bar for Vertical Profile Design

»  Select Design model in Model Name and select MCOO in String Name and click Next.

Quick Profile: Design Model ? X
Design Model Next>
Model Name
DESIGN Z] Cancel
String Name Im j Open Set-up...
Options >>
QY0001

Figure 19: Model selection for Quick Profile

»  Select Triangulation model in Model Name and select MCQO in String Name and click Next.

Quick Profile: Existing Profile Model ? X

Existing Surface Model | Nest >
Model Name
[TRiA (TRIA -] Siack

Cancel
[~ Add Collinear Profiles
-

QY0002

Figure 20: Triangulation selection for Quick Profile
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» Then open a designing tool and with the help of this designing tool, will design vertical profile of the road.

o=
Lire@s B= %00+ X
2 Grade % Cut %, Fill %2 Difference Horizontal Radius Vertical Exaggeration
@& Al r
mm @ Al 000411 558.008 Unknown v |[id
=l avoio1
Figure 21: Tool bar for Vertical Profile
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Figure 22: Vertical Profile with tool bar
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Figure 23: Vertical Profile output
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5) Horizontal Alignment Report
For Horizontal alignment report follow the steps which are given below-
» From the main menu bar, select Report > Alignment Reports > Horizontal Alignment Report.

Report | Quantities Add-Ins Help Default v [
Dynamic Reports...
Standard Reports 4
Geometric Reports »
l Alignment Reports ’ [ Horizontal Alignment Report...
Report Section Wizard... Vertical Alignment Report...
Custom String Details... Chainages and Offsets...

Figure 24: Main menu bar for Horizontal Alignment Report

»  Select Design model in Model Name and select MCOO in String Name and click Next.

Horizontal Alignment Report: Model Details ? X

Design Model
Model Name I Next > I
[DESIGN ] |
Sting Name MCO0 =

—I Cancel |
IRoad Centrelines (MC) LI

HRO001

Figure 25: Model selection for Horizontal Alignment Report

» Tick on details which you want to need and click Next.

Horizontal Alignment Report: Details ? X

Arc Details ] Transition Details | Straight Details | N
&vailable Options Selected Options Dec

Col

 Intersection Point Chainage |3 |0 | < Back
Intersection Point X 3 0

Intersection Point Y’ 3 1] c |
Arc Start Chainage 3 0 SED
Arc End Chainage 3 0

Radius 3 0

Hand of Arc 3 0

= (= i

Save Setup...

Show Defaults

HR0002

Figure 26: Details selection for Horizontal Alignment Report
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» Save the report and click finish.

Horizontal Alignment Report ? X
Horizontal Alignment Report |
Model: DESIGN |
Sting:  MCOO
Units: Metric < Back |
Date: 29-05-2023 16:04:25

[ Cace ]
xxxxxxxx Element 1 S"aightxxxxxxxx F|n|sh |
xxxxxxxx Element 2 A[cxxxxxnxx
Intersection Point Chainage 0+736.354
Intersection Point X 757012123
Intersection Point Y 2587547760
Arc Start Chainage 0+714116
Arc End Chainage 0+758.590
Radius 2000.000
Hand of Arc Right

SavetoFile...
xxxxxxx!EIement 3 S"aightxxxllxxx
HRO003

Figure 27: Horizontal Alignment Report

6) Vertical alignment report-
For Vertical alignment report follow the steps which are given below-
» From the main menu bar, select Report > Alignment Reports > Vertical Alignment Report.

Report | Quantities Add-Ins Help Defauit v [
Dynamic Reports...
Standard Reports »
Geometric Reports »

‘ Alignment Reports ’ Horizontal Alignment Report...
Report Section Wizard... I Vertical Alignment Report...

Custom String Details... Chainages and Offsets...

Figure 28: Main menu bar for Vertical Alignment Report

»  Select Design model in Model Name and select MCOO in String Name and click Next.

Vertical Alignment Report: Model Details ? X

Design Model
Model Name | Next > I
[DESIGN | |
Reference String Name MCOD| =

—] Cancel |
IRoad Centrelines (MC) L‘

YRO101

Figure 29: Model selection for Vertical Alignment Report
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» Tick on details which you want to need and click Next.

Vertical Alignment Report: Details

Available Options Selected Options Dec Col
IP Level 3 1] ==
Curve Length 3 1] —t < Back I
Curve Type 3 1] -
Gradient 3 0 = c |
K Value 3 0 shes I
I MValue |3 |0 |

Open Setup. .. I
Save Setup... I
Show Defaults I
VRO102
Figure 30: Details selection for Vertical Alignment Report
» Save the report and click finish.
Vertical Alignment Report 2 x
Vertical Alignment Report
Model : DESIGN
String: MCO0O0
Units: Mectric
Date : 25-05-2023 1€:59:25
........ S s 1 GRS
Gradient Length 38.9584
Gradient 1.077
““““ Element 2 Vertical Curve***++arax
IP Chainage 0+138.584
IP Level 450.€10
Curve Length 200.000
Curve Type Hog =
Curve Start Gradient 1.077 Save to File...
VRO103

Figure 31: Vertical Alignment Report
1. RESULTS AND DISCUSSION

Plan Of The Balampur Ghat Section On Google Earth

Existing gt
Alignment *

S Eaidmpur Ghaat

Image © 2023 Airbus

Figure 32: Plan of Existing Alignment
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9 Indian GasiAgen|

v o AL
®Balampur Ghaat - "i = .
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Image © 2023 Airbus

Figure 33: Plan of Improved alignment-1

® salampur Ghaat

Image © 2023 Airbus

Figure 34: Plan of Improved alignment-2
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Alighment

°Balar;vpur Ghaat

Image © 2023 Airbus

Figure 35: Plan of both improved alignment with existing road
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758392.6571, 2588109.2598, 498.1399 KeyPt of | & |Default 4
0 @& SmemogE@®F O0® Q9 na RIS 0 @
Figure 36: Plan of Existing ghat section in AutoCAD
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I AutoCAD 2007 - [D:APANKANSATIAth sem\MX Balampun\Output\Existing\New Existing Road Profile.dwg] = [s) X
i File Edit View Inset Format Tools Draw Dimension Modify Express Window Help 5
I KE2RD 9 |«DO 2 #| XX BnEREYB @] Lo [ | &

[l ool 1 u] s¢|m —— —

dHO 0 LOONIDOLN\N
FEEICHEEMP B SR

XYL O

>EPNE -

W A

it, or right-click to display shortcut menu.
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Figure 37: Profile of Existing ghat section in AutoCAD

Table 3: Horizontal Alignment report of existing ghat section

Start Chainage of End Chainage of Hand Design
Sl . HIP o]
_ _ _ Transition Cha ‘ Sp _
Easting, X Northing, Y Radius Lengt K ee Superelevation, e
h L, | Transiton | Curve | Curve Transition ina A d,
ge r
c Vv
1 757012.123 | 2587547.760 2000.000 0.000 12+314 12+359 12+336 Right 100 NR
2 757089.095 | 2587572.395 2000.000 0.000 12+395 12+440 12+417 Left 100 NR
3 757399.028 | 2587679.322 2000.000 0.000 12+715 12+775 12+745 Left 100 NR
4 757456.068 | 2587700.906 2000.000 0.000 12+777 12+835 12+806 Right 100 NR
5 757645.713 | 2587766.388 2000.000 0.000 12+989 13+024 13+007 Left 100 NR
6 757799.517 | 2587822.558 4000.000 0.000 13+142 13+199 13+170 Right 100 NR
7 757905.441 | 2587859.550 2000.000 0.000 13+264 13+302 13+283 Left 100 NR
8 758143.055 | 2587946.935 800.000 30.000 13+481 13+511 13+560 13+590 13+536 Right 80 3.56%
9 758224.394 | 2587968.949 200.000 0.000 13+613 13+627 13+620 Left 30 NR
10 758295.977 | 2587993.044 140.000 0.000 13+647 13+740 13+694 Left 25 NR
11 758373.623 | 2588111.536 40.000 0.000 13+816 13+849 13+833 Right 20 4.44%
12 758525.487 | 2588138.804 200.000 0.000 13+972 14+000 13+986 Right 30 NR
13 758618.267 | 2588142.691 150.000 0.000 14+051 14+106 14+078 Right 25 NR
14 758742.071 | 2588100.844 80.000 0.000 14+159 14+248 14+204 Left 20 NR
15 758802.516 | 2588161.653 150.000 0.000 14+258 14+310 14+284 Left 25 NR
16 758852.266 | 2588265.607 400.000 20.000 14+341 14+361 14+437 14+457 14+399 Right 50 2.78%
17 758954.132 | 2588394.292 800.000 0.000 14+551 14+574 14+563 Right 60 NR
18 758982.663 | 2588427.812 1000.000 0.000 14+590 14+624 14+607 Left 60 NR
19 759044.313 | 2588505.441 500.000 0.000 14+693 14+718 14+706 Right 50 NR
20 759076.389 | 2588541.886 1000.000 0.000 14+738 14+770 14+754 Left 60 NR
21 759282.928 | 2588798.132 400.000 55.000 14+992 15+047 15+120 15+175 15+083 Left 80 7.00%
22 759463.122 | 2589249.804 2000.000 0.000 15+542 15+598 15+570 Left 100 NR
23 759507.740 | 2589374.469 2000.000 0.000 15+674 15+731 15+702 Right 100 NR
24 759542.124 | 2589462.560 2000.000 0.000 15+786 15+808 15+797 Right 100 NR
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Table 4: Vertical Profile report of existing ghat section

Sr. .
Curve Curve . Design
0
N IP Chainage IP Level Len Typ nl n2 #oGrade Diff. K Value Spe
(n1-n2)
gth e ed
1 12129.489 491.159 300 Sag 0.216 1.337 -1.121 267.727 100
2 12675.6 498.458 300 Hog 1.337 -0.725 2.062 145.497 100
3 12987.998 496.192 200 Sag -0.725 1.191 -1.916 104.35 100
4 13282.531 499.701 300 Hog 1.191 0.824 0.367 816.851 100
5 13787.735 503.864 300 Hog 0.824 -6.5 7.324 40.961 80
6 14298.454 470.667 250 Sag -6.5 0.932 -7.432 33.639 80
7 14782.532 475.178 400 Hog 0.932 -1.981 2.913 137.311 100
8 15686.844 457.262 300 Sag -1.981 0.811 -2.792 107.446 100
t!‘i MX: D:\PANKAJ\SATI\4th sem\MX Balampur\MX Balampur.mmd - [d:\pankaj\sati\4th sem\mx balampur\draw.dgn] - Bentley MXROAD V8i (SELECTseries 2) = 0 X
File Edit Element Settings Tools Utilities Workspace Applications MX Window Help @ Defaut v D 0~ '_' 0~ E 0~ ‘DES‘GNGP”D’” :_! [ MO &
B-0-8-B-3-0-QO8F QD R im
o View1- Top, MX E=E
BrOx-/ARRRBEYP|WEE S 986

Autoconvert OFf &) O @ V/ %/{E
& M v || 1|2|3|4|5|s|7|3 CAD v MXKeys v SngePick v Uocked v (1) MXOutput Window (@)759035 559, 2567577.224
Pan View > Select View 758639.514, 25881440622, 476.4414 KeyPt & |Defaut 4

al, B memO@EOROOS " QM ~o 5 cum o

Figure 38: Plan of Improvement-1 in AutoCAD
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Figure 39: Profile of Improvement-1 in AutoCAD

Table 5: Horizontal Alignment report of Improvement-1

107,167 95.1830, 00000 sap| GRID| ORTHO) POLARI [osnap [oTRack [pucs [ovw LW [MopL Y .

Start Chainage of End Chainage of Hand
Sl . 0 Design Super
. Northing, . Transition HIP . f gpe pelev
Easting, X Radius Length Chai -
Y L Transition | Curve Curve | Transition nage A ed, ation
y Ls r \Y , €
c
1 757012.123 | 2587547.76 2000 0 12314.12 | 12358.59 12336.353 Right 100 NR
2 757089.095 2587572.4 2000 0 12394.71 | 12439.63 12417.169 Left 100 NR
3 757399.028 | 2587679.32 2000 0 12715.49 | 12774.56 12745.025 Left 100 NR
4 757456.068 | 2587700.91 2000 0 12776.73 | 12835.29 12806.008 Right 100 NR
5 757645.713 | 2587766.39 2000 0 12990.45 | 13022.82 13006.638 Left 100 NR
6 758151.568 | 2587949.56 800 30 13488.868 | 13518.87 | 13570.39 | 13600.391 13544.63 Right 80 3.56%
7 758285.593 | 2587988.95 150 30 13616.432 | 13646.43 | 13720.87 | 13750.868 13683.65 Left 50 7.00%
8 758378.828 | 2588103.17 150 20 13763.457 | 13783.46 | 13874.46 13894.46 13828.959 Right 40 4.74%
9 758593.108 | 2588150.92 300 0 13961.13 | 14128.64 14044.883 Right 40 NR
10 758765.285 2588095.7 100 20 14128.764 | 14148.76 | 14277.33 | 14297.333 | 14213.049 Left 40 7.00%
11 758856.338 | 2588263.86 400 55 14320.518 | 14375.52 | 14412.11 | 14467.113 | 14393.816 Right 80 7.00%
12 759044.313 | 2588505.44 2000 0 14675.01 14724.9 14699.958 Right 100 NR
13 759282.64 | 2588797.57 400 55 14984.955 | 15039.96 | 15113.96 | 15168.963 | 15076.959 Left 80 7.00%
14 759463.122 2589249.8 2000 0 15547.52 | 15580.22 15563.87 Left 100 NR
15 759542.124 | 2589462.56 2000 0 15763.26 | 15818.37 15790.817 Right 100 NR
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Table 6: Vertical Profile report of Improvement -1

Sr. .
Curve Curve . Design
0
IP Chainage IP Level Len Typ nl n2 #oGrade Diff. K Value Spee
(n1-n2)
gth e d
1 12129.489 491.159 300 Sag 0.216 1.337 -1.121 267.618 100
2 12675.39 498.458 300 Hog 1.337 -0.725 2.062 145.506 100
3 12987.998 496.192 200 Sag -0.725 1.191 -1.916 104.376 100
4 13282.49 499.701 300 Hog 1.191 0.082 1.109 270.422 100
5 13670.863 500.019 300 Hog 0.082 -4.2 4.282 70.061 80
6 14356.779 471.211 250 Sag -4.2 0.932 -5.132 48.715 80
7 14782.478 475.177 400 Hog 0.932 -1.981 2.913 137.321 100
8 15686.844 457.262 300 Sag -1.981 0.811 -2.792 107.45 100
% MX: D:\PANKA\SATI\4th sem\MX Balampur\MX Balampur.mmd - [d:\pankaj\sati\4th sem\mx balampur\draw.dgn] - Bentley MXROAD Vi (SELECTseries 2) = 0 X
File Edit Element Settings Tools Utilities Workspace Applications MX Window Help @ Defaut v D ey ==g0ny E 0 v :[DESIGNOPTION2 ﬂa uE a3 &
B-5-8-B-F-%-0O8ARID Rriwe -
o View1-Top, MX =El=
Rlox-/AR_REH4B|WHE S 726

Autoconvert OFf (] / '4/?

& Mx | & 1|2|3|4|5|5|7|3 CAD  v|MXKejins v SingePck v Unocked v (] MXOutput Window (@)750416710, 2586287731
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ERImMOBEOROOSTOROM ~o i cus 0

Figure 40: Plan of Improvement-2 in AutoCAD
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Table 7: Horizontal Alignment report of Improvement-2

Sl. ! ) Northing, } Transition Start Chainage of End Chainage of HIP ) Hand of Design Super )
d Easting, X v Radius Length, Chai A Spee elevatio
Ls — — nage rc d Vv ne
Transition Curve Curve Transition

1 757012.123 | 2587547.76 2000 0 12314.12 | 12358.59 12336.353 Right 100 NR

2 757089.095 2587572.4 2000 0 12394.71 | 12439.63 12417.169 Left 100 NR

3 757399.028 | 2587679.32 2000 0 12715.49 | 12774.56 12745.025 Left 100 NR

4 757456.068 | 2587700.91 2000 0 12776.73 | 12835.29 12806.008 Right 100 NR

5 757645.713 | 2587766.39 2000 0 12990.37 | 13022.91 13006.638 Left 100 NR

6 758146.304 | 2587947.51 1000 55 13471.682 | 13526.68 | 13551.31 | 13606.306 13538.994 Right 100 4.44%

7 758773.447 | 2588127.26 150 30 14114.539 | 14144.54 14235.8 14265.798 14190.169 Left 50 7.00%

8 758862.817 | 2588277.76 500 45 14294.928 | 14339.93 | 14387.79 | 14432.789 14363.859 Right 80 5.69%

9 759044.313 | 2588505.44 2000 0 14639.63 | 14670.45 14655.04 Right 100 NR

10 759282.64 2588797.57 400 55 14940.037 | 14995.04 | 15069.05 | 15124.046 15032.042 Left 80 7.00%

11 759463.122 2589249.8 2000 0 15502.6 15535.31 15518.953 Left 100 NR

12 759542.124 | 2589462.56 2000 0 15718.35 | 15773.45 15745.9 Right 100 NR
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Table 8: Vertical Profile report of Improvement-2

Sr. .
[ IP Chainage | IP Level CurI\_lzn CUT\{_G; nl n2 %Gra(?]el_DniZf)f. K Value Desgpne
gth pe ed
1 12129.489 491.159 300 Sag 0.216 1.337 -1.121 267.618 100
2 12675.479 498.459 300 Hog 1.337 -0.725 2.062 145.465 100
3 12988.092 496.191 200 Sag -0.725 0.989 -1.714 116.662 100
4 13591.702 502.161 400 Hog 0.989 -4.2 5.189 77.086 100
5 14333.732 470.996 250 Sag -4.2 0.932 -5.132 48.714 80
6 14782.458 475.178 300 Hog 0.932 -1.981 2.913 102.987 100
7 15686.844 457.262 300 Sag -1.981 0.811 -2.792 107.45 100

A. Improvement Analysis
The improvement benefits of the Balampur ghat section of SH-18 (Bhopal — Vidisha Road) are given in Table 4.7.

Table 9: Improvement Analysis

No Description Before Improvement After Improvement

1 Length of the section 2.000 km 1.940 km

Before improvements the
2 Horizontal alignment horizontal alignment was
unsafe for road users.

The horizontal alignment has been
safe for the road users.

The vertical alignment was The vertical alignment has less
3 Vertical alignment steeper (> 6.4%) before the than 4.3% gradient after
improvement. improvement.

There were 7 nos. of improper
horizontal curves and 7 nos.| There is no improper curve. The
of curves which has no all curves are as per IRC
transition curves as per IRC recommendations.
recommendations.

Improper horizontal
4 curves
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B. Cost Analysis

The existing road stretch is in hilly terrain and for the improvement of the existing road stretch of the Balampur ghat section will
have to cut and The normative cost analysis of the both improved alignments are done as per the Ministry of Road transport and
Highways (MoRTH) Letter no. RW/NH-24036/27/2010-PPP, Dated 25/04/2018 for flexible pavement. Cost analysis of the both
improved alignments is given below in Table 4.8.

Table 10: Cost Analysis

NS(') Description Unit Improvement - 1 Improvement - 2
1 Total length of the section km 1.990 1.940
) Length of cutting portlo_n (Green_fleld alignment) in - 1180 1.440

Hilly terrain

3 Length of widening section in plain terrain km 0.810 0.500

Normative cost for greenfield alignment 2 lane +
4 paved shoulder as per Table no. 2 (Amount - Rs|  km 9.60 9.60

in Crore)
Normative cost for widening to 2 lane + paved
5 shoulder as per Table no. 1 (Amount - Rs in km 3.19 3.19
Crore)

Amount for greenfield alignment 2 lane + paved

6 shoulder (Amount - Rs in Crore) ) 11.328 13.824
Amount for the widening of the road stretch

7 (Amount - Rs in Crore) ) 2.584 1.595
8 Total amount (Amount - Rs in Crore) - 13.912 15.419

C. Summary of the Analysis
From the design outputs, summery of the improved alignments of the existing road is given below in Table 4.9

Table 11: Summary of the Analysis

NS:)' Description Existing Alignment Improved alignment-1 Improved alignment-2
1 Length of alignment 2.000 km 1.990 km 1.940 km
2 Terrain Hilly Hilly Hilly
3 Min. design speed 20 kmph or less 40 kmph 50 kmph

No. of improper horizontal 7 i i
4 curves

No. of horizontal
5 curves at which speed < 40 7 - -
kmph.
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No. of horizontal

® | curves at which radius < 75 m. 1 ) )
7 |Max. gradient in vertical profile 6.5 % 4.2 % 4.2 %
Utilization of Existing 2.000 km 0.810 km 0.500 km
8 road
9 Civil cost in crore 6.38 13.912 15.419
1. Radius and design speed are| 1. Radius and design speed
- as per IRC are as per IRC
recommendations. recommendations.
10 Merits
2. Less No. of curves and
- - Geometry is generally
straight.
1. Alignment passes through| 1. Alignment passes through | 1. Alignment passes through
forest forest forest
11 Demerits

2. It has safety issues

3. It has more curves

3. It has more curves

A. Conclusion
The objectives of the study were “Improvements in the Horizontal Alignment and Vertical Profile of Balampur ghat section in
Bhopal - Vidisha SH-18 (From km 13.000 to km 15.000) in Madhya Pradesh as per IRC recommendations. There are designed two
improvements of the existing road from km 13.000 to km 15.000 as per IRC recommendations. Improved alignment-1 is slightly
inner side or right side of the existing road and improved alignment-2 is straight from km 13.650 to km 14.050 in inner side or right
side.

(AVA

CONCLUSION

The conclusion of the research work for designing of the horizontal alignment and vertical profile of the existing ghat section are
given below-
All the improvements are adopted as per IRC recommendations.
Desirable minimum radius is adopted in horizontal curves in both improved alignments. Only at chainage km 14.213 in
improved alignment — 1, the curve radius is less than the desirable minimum but that is more than the absolute minimum radius
values.
Ruling gradient values are adopted in improved vertical alignment.
The adopted design speeds for mountainous terrain are 60 kmph and 40 kmph for ruling design speed and minimum design
speed respectively.
The both improved alignments are designed to reduce consistency of accidents as well as delay time at existing road and to
increase the safe design speed for road users.
After the improvements of the existing alignment, the human and economic losses will be reduced.
The travel time will be reduced at the ghat section and the maintenance of the vehicles will also reduce.
The goods transport will be easier and faster for the supply of the product.

The improved alignment — 2 is the better option for the existing road stretch improvements.
10) High accuracy in the design with saving the time were achieved by using MXROAD.

1)
2)

3)
4)

5)

6)
7)
8)
9)
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B. Study Benefit After Improvements

As per this research study, after improvements in the existing road section many types of benefits will meet to the road users which
are given below-

1) The design speed of the ghat section will be > 40 kmph.

2) The alignment will be safer for road users.

3) The delay time due to slow speed of the commercial vehicles at the ghat section will be minimized.

4) The accident-prone area will be over.

C. Scope for the Future

1) Further studies need to be traffic studies and design carriageway of the road.
2) Further studies need to be pavement design.

3) Further studies need to be preparation of cost estimate.
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